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Operating Instructions for PhyTip ® MEA  

Personal Purification System 
 

 

 

 Introduction 
 

 

In order to extend the benefits of PhyTip® columns for protein purification and 

enrichment, PhyNexus has developed the PhyTip® MEA Personal Purification System as 

the platform of choice for fully automated protein purification and enrichment. When 

used with the PhyNexus Operating Software, this system offers validated procedures that 

maximize the purification and enrichment efficiency of the various chromatography 

resins available for PhyTip® columns. In combination with the fully programmable 

positioning of the 12 channel system, and the ability to place samples, PhyTip® columns, 

wash stations and elution plates in any available position, the MEA Personal Purification 

System is an ideal automated system for small scale protein purification. 
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Section A 
 

 

1. Unpacking 
 

Each MEA system contains the following: 

 

1. MEA Personal Purification System 

2. Two power supplies (one for the MEA, one for the chiller). Use only the power 

supplies provided, see page 73 for ratings.  

3. MEA 12-channel head(s). The 12-channel heads(s) will be provided with 

attachment clamp already installed, ready to attach to the MEA tower. 

4. MEA 12-channel head USB Cable  

5. Software CD 

6. MEA USB communications cable 

7. Accessory pack including rack bars and evaporation hold-down cover 

8. Consumables pack including PhyTip Evaporation Covers, Holders, reservoirs and 

96-well plates 

9. Literature, documents and Operating Instructions pack 

 

 

 

If these separate items are not in the original outer packing, please call PhyNexus Inc, at 

408-267-7214. 

 

Remove all contents from their individual packs and prepare to install the system. 
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2. Setting up the system 
 

This section is divided into: 

 

1. Initial location and set up of system parts 

2. Installing the software 

3. Powering up the system 

4. Cleaning the system 

 

 

1. Initial location and set up of system parts 
 

Quick guide: 

 

Once all contents have been removed from their individual packs, locate the MEA 

instrument and place it close to the computer to be used for operation. Using needle nose 

pliers unhook the springs holding the Tower Support Blocks together. Connect the MEA 

USB communications cable between MEA USB port and the computer USB port. 

Connect the power supply to the MEA and separate power to the chiller. The PhyNexus 

software is preloaded on the supplied computer. Locate the Software CD and install on 

any additional computer if desired. Run software and attach MEA head to the MEA 

tower. 

 

Detailed description: 

 

Instrument placement. 

 

Remove the MEA system from its packing box and place on the specified lab bench. This 

must be close enough for three power supplies that are required to operate the MEA 

system. Enough vertical clearance must be given for the MEA tower to move along the x-

axis (maximum height above the bench = 24ò), and there must be enough space on the 

right hand side of the instrument to reach/press the red Emergency Stop button and the 

control switch for the chiller. The surface for the MEA should be smooth, flat and stable. 

 

The full instrument dimensions are: 

 

Width:  32ò 

Depth:   14ò, plus 6ò to accommodate all necessary power supplies and cables. 

Height:  24ò 

Weight:  55 lbs 

 

Installing the instrument. 

 

Each MEA is shipped with the ordered 12-channel MEA head(s), either ME200+ (for 

200+ PhyTip columns that operate with volumes up to 200 ɛL) or ME1000+ (for 1000+ 

PhyTip columns that operate with volumes up to 1000 ɛL) with the alignment clamp 
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attached. Remove the MEA system from its packing and install this unit onto the 

receptacle on the robot tower as follows: 

 

1. The black alignment clamp has been factory installed on the 12-channel system. 

The LCD on the 12 channel system points to the right and the clamp has an 

alignment slot at the rear which will interface with an alignment bar on the 

moving Z-head on the MEA tower.  The moving Z-head is a round bar with a 

single flat surface that extends forward of the robotic tower and the alignment bar 

that is parallel to the x-axis of the system.  

 

2. Locate the single attachment hole at the rear of the clamp and push the clamp onto 

Z-head bar.  

 

3. With the alignment bar and alignment slot parallel to each other, push the clamp 

mechanism in fully until it snaps in place.  

 

4. Turn the knurled screw on the side of the clamp to finally tighten the clamping 

mechanism in place. 

 

To exchange the 12channel head, simply loosen the knurled screw, ease the clamp from 

the alignment slot and pull away from the z-head bar. Repeat the first four steps with the 

alternate 12-channel head. 

 

When replacing a 200+ channel system with a 1000+ 12 channel system, remove the 

front and rear rack bars that are at positions 1 and 2. There are three Allen key screws 

(two at the front and 1 at the rear).  Unscrew the three screws and remove the rack bars. 

The new height of positions 1 and 2 will be ready for the deep tip boxes used with the 

1000+ 12-channel head. 

 

Take the MEA 12-channel head USB cable that is attached to the 12-channel system and 

route it through the cable management channel on the robot track down to the computer 

USB port. This is achieved by just pressing the cable into the track and snapping it in 

place. 

 

Take the MEA power supply and attach to the supply port on the rear of the MEA 

(labeled ñPowerò). 

  

Connect the power supply to the rear of the instrument in the port labeled ñChiller Plate.ò 

 

Take the MEA USB communications cable and connect between the MEA USB port and 

another USB port on the computer. 
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Front view of MEA system.  

 

 
 

Side view of MEA system.  
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Rear view of MEA system showing power supply inlets and cable 

attachment points 
 

Power inlet and On/Off 

switch for cooling 

accessory

Power inlet and On/Off 

switch for MEA system

 



 

Version 1.7.9  Mar. 7, 2013 

Copyright © 2013, PhyNexus, Inc., All Rights Reserved. 

 

9 

2. Install the software on the PC (optional) 
 

The MEA Personal Purification System comes equipped with a computer. The user may 

choose to install the software on additional computers. The PhyNexus Operating 

Software is designed to operate with PCs running Windows 8. With the computer turned 

on, insert the software disc into the CD or DVD drive of the system, double click on the 

setup icon, and follow the install instructions on the screen.  

 

 

 

 

3. Powering up the system 
 

With all power supplies connected and the software installed in the computer, turn the 

system on by pressing the power supply switch at the rear of the MEA. A green ñPower 

Onò light will illuminate at the front of the instrument. If the green light does not 

illuminate, first check that all connections have been made and secondly make sure that 

the red emergency stop button has not been depressed. To do this, turn the emergency 

button in the direction for Reset (clockwise).  

 

Turn on the chiller by, pressing the power switch at the rear of the instrument and then 

turning the setting switch on the right of the instrument to the appropriate setting.   

 

4. Cleaning the system. 
 

The MEA Personal Purification System can be cleaned by wiping with a damp cloth. Do 

not use solutions containing high concentrations of bleach or other oxidizing agents.   
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3. Using the PhyTip MEA Purification System 

 
This portion of the manual is divided into the following sections: 

 

1. Setting the instrument deck 

2. Easy to Use Quick Guide Software Instructions 

3. Easy to Use Quick Guide Operating Instructions 

4. Detailed Software Information and Instructions 

 

 

1. Setting the instrument deck 
 

The instrument deck can be configured in a number of different ways, but the standard 

configuration is as follows: On the left there are two positions for Tip boxes and to the 

right of these, there is enough space to hold 5 plates (standard SBS) and one reagent 

reservoir.  

 

Position 1.  PhyTip Box  

Position 2.  PhyTip Box 

Position 3.  Plate position (Plate 1) 

Position 4.  Plate position (Plate 2) 

Position 5.  Plate position (Plate 3) 

Position 6.  Reservoir position 

Position 7.  Plate position (Plate 4) 

Position 8.  Plate position (Plate 5) 

 

If necessary, the positions of these plates can be changed by moving the attached pins and 

replacing them in the appropriate positions. This maintains perfect alignment of each 

plate in each position during MEA operation. 

 

The chiller requires its own power supply. When on, the chiller will maintain the last two 

positions under the deck (Positions 7 & 8) at a temperature of approximately 4-6
Ǔ
C. This 

temperature can be modified by turning the control knob on the right side of the 

instrument. Position 1 represents the coldest setting and position 5 the warmest setting 

available as demonstrated below:   

 
Position Approximate 

Temperature (°C) 

1 4 

2 8 

3 12 

4 16 

5 20 
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For a standard purification set up: 
 

Position 1: PhyTip Columns ï new/unused 

 

For the MEA system, these should only be PhyTip columns with the appropriate part 

numbers for the 12 channel system that is being used, e.g. 200+ or 1000+, and the affinity 

resin that is required e.g. PTR 92-05-01 (Pack of 96 PhyTip columns for the 200+ system 

with 5 µL Protein A as affinity resin). 

 

Position 2: Empty box for used PhyTip columns or standard Rainin LTS pipette tips 

 

Used PhyTip columns can be replaced in their original box or if required, in a separate 

empty box. 

 

Position 3: Extra plate position or Equilibration Plate 

 

This extra position can be used for a number of different applications e.g. extra wash 

step, equilibration, etc.  

 

Position 4: Wash Plate 1 

 

Depending on the specific application, a number of different types of wash plates may be 

placed in this position, e.g. deep well 96-well plates. Care must be taken when choosing 

the type of deep well 96-well plate. When using the 1000+ system, PhyNexus 

recommends the use of 2 mL, square well plates with a pyramid bottom (PhyNexus Part 

Number PCP 96-20-10). 

 

Position 5: Wash Plate 2 

 

Depending on the specific application, a number of different types of wash plates may be 

placed in this position, e.g. deep well 96-well plates. Care must be taken when choosing 

the type of deep well 96-well plate. When using the 1000+ system, PhyNexus 

recommends the use of 2 mL, square well plates with a pyramid bottom (PhyNexus Part 

Number PCP 96-20-10). 

 

Position 6: Reservoir Position 

 

Depending on the application and specific affinity resin used, the Reservoir Position can 

be used as a holder for neutralization buffer. When used in this mode, the reservoir is 

filled with sufficient volume of neutralization buffer. Also Tip box position 2 should be 

used to hold standard Rainin LTS Pipette Tips. The system should then include the 

incorporation of a neutralization step using the Reservoir Position; use PhyNexus 

ñreservoir insertsò (PhyNexus Part Number 96-60-00).   The maximum total volume per 

well for each of the reservoir wells is approximately 300 ɛL, therefore maximum 

recommended volume to be transferred (assuming 8 rows in a full 96-well plate) is 35 

ɛL.  
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Position 7: Sample Plate (samples to be purified) 

 

Depending on the specific application, a number of different types of sample plates may 

be placed in this position, e.g. deep well 96-well plates. Care must be taken when 

choosing the type of deep well 96-well plate. When using the 1000+ system, PhyNexus 

recommends the use of 2 mL, square well plates with a pyramid bottom (PhyNexus Part 

Number PCP 96-20-10). 

 

Position 8: Elution Plate 

 

When using the 1000+ system, PhyNexus recommends the use of 2 mL, square well 

plates with a pyramid bottom (PhyNexus Part Number PCP 96-20-10). When using the 

200+ system, PhyNexus recommends the use of the PhyTip Elution Plates (Part number 

PCP 96-00-10) for the final step of elution. These plates have v-bottoms which maximize 

the process of elution. It is also recommended to cover the plates, once the elution buffer 

has been added, with a PhyTip Plate Cover (Part number PCP 96-10-20) and PhyTip 

Plate Holder (Part number PCP 96-10-50). 

 

With the chiller activated, both positions 7 and 8 can be maintained at sub ambient 

temperatures.  
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2. Easy to use Quick Guide Software Instructions 
 

The Auto controller Operating Software has been designed for simple to use automated 

methods that have been preprogrammed into the system. However, any combination of 

movements and positions can be built into a user defined method. To begin, PhyNexus 

recommends that the user start with the built-in methods and subsequently modify these 

to match the requirements of the application. 

 

Methods manage the entire process of moving the robotics tower with 12 channel system 

attached to perform the Capture, Purify and Enrich process for all of the defined samples. 

Protocols manage the individual steps of the Capture, Purify and Enrich process. A 

method is a series of protocols and robotic movement/position instructions that fully 

automate the entire process of purifying a full plate of 96 samples. To load the software 

onto a PC, simply insert the CD into the CD or DVD drive of the PC and follow the 

installation instructions on the screen.  

 

For simplest use of the system, run the preprogrammed methods for any of the given 

affinity resins. To do this, go to File, then Open. This will bring down a screen that 

shows either Method or Protocol, click on Method to show all of the stored Methods. 

Open the standard method IMAC; this will bring down the operational screen. Now go to 

Method and click on Edit ; this will show all of the individual steps of the method. 

 

Click on any one of the individual steps of the methods to show the options screen; this 

will be split into two sections. The top section deals with the operation of the 12 channel 

system (controller), while the bottom section deals with robotics movement of the 

autocontroller. Actions that are available are: 

 

Top Section: 

 

Execute:      executes a stored protocol, e.g. Capture 

 

Audible Alert:           introduces an audible alert at the end of an action 

 

Home (controller):   homes the 12 channel system to a zero volume 

 

Pause for Operator: builds in an automatic pause in the method 

 

Comment:                 allows operator to build in an automatic comment or prompt 

between actions 
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Bottom Section: 

 

Home Autocontroller: returns the robotics tower and 12 channel system to registered 

                                    Home position 

 

Down:                    moves the robotics tower with 12 channel system down to                              

designated step position (0 is the highest position above the deck 

and 4725 is the position closest to the deck). A dialog box will 

appear where the number of steps can be entered. 

 

Up:                           moves the robotics tower with 12 channel system up to the 

designated step position (0 is the highest position above the deck 

and 4725 is the position closest to the deck). A dialog box will 

appear where the data can be entered, if left unchecked the default 

is all the way up to the zero position. If data is entered, this 

information is only a delta, meaning that if 20 is entered the tower 

will move up 20 positions and NOT to location number 20. 

 

External Pump:       operates an external pump (when fitted) via the rear serial port, 

allowing for the automated addition of reagents or activation of 

vacuum system.  

 

Rotate: rotates the vertical 12 channel system (clockwise = 0 to + 335 and 

Counterclockwise = 0 to ï 25)  

 

Sub method: allows user to define a specific action and store this in memory e.g. 

ñCostar 200+ V bottom plateò could reference the specific height 

of a novel plate, once stored in memory, z numbers would not need 

to be recalled. 
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Position: moves the robotics tower with 12 channel system to the desired x-axis 

location on the deck. There are a total of 39,100 positions along the x-axis. 

 

Position/Row moves the robotic tower with 12 channel system to the desired 

Position (1-8) and specific Row (1-8).  This command assumes the 

use of plates that have 8 rows (e.g., standard 96 well plates, certain 

48 well plates, etc.). 

 

Load Tips: loads a row of 12 PhyTip columns onto the 12 channel system. 

This also incorporates the function of going down to the tips, 

loading the tips and moving them out from the tip box. This is set 

for the default PhyTip columns and standard Rainin LTS tips for 

neutralization. 

 

Eject: ejects all 12 PhyTip columns from the 12 channel system 

 

XMOV: Auto movement to specify position along x axis. CAUTION: This 

action does NOT move tower to zero position.  
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3. Easy to Use Quick Guide Operating Instructions 
 

A. Calibrating the Instrument  

 

Once installed in the correct position the instrument should be recalibrated in order to 

correctly zero the position of the robotic tower. It is also recommended that for each 

pipettor, (200 or 1200) calibration should be checked and stored. 

To access the calibration software go to the general toolbar on the operating software and 

click on Options, this will display Communications, Syringe, Calibration, Manual 

Positioning and SubMethods. Click on Syringe and select either 200 or 1200 (for the 12 

channel system that uses 200+ tips, choose 200: for 12 channel system that uses 1000+ 

tips, choose 1200). Next, click on Calibration , this will now display a screen with 

ñCheck Alignmentò and three dialog boxes for x-position, rotation and z-axis.  

 

 
Click Check Alignment, and the 12-channel system will move to the zero position on x-

axis and then down to the normal tip loading height for the specific system that is 

connected e.g. 200 or 1200. Adjustments can be made for x-axis, z-axis and rotate as 

follows: 

For the x-axis, adjust the +1 and -1 settings to align the nozzles on the 12-channel system 

in the center of the tips. 

For the z-axis, adjust the +1 and -1 settings to bring the base of the nozzles on the 12-

channel system to approximately 0.5 mm or 1.5 mm above the top of the tips for the 200+ 

and 1200+ systems, respectively. 

For the rotation, adjust the +1 and -1 settings to bring the plane of the base of the nozzles 

on the 12-channel system parallel with the plane of the top of the tips. 

Once complete, click Save. This will save the calibration settings for the specific 12 

channel system. The software recognizes the difference between a 200+ system and 

1200+ system and applies the saved settings accordingly. 
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B. Manual Positioning 

 

This allows the user to position the 12-channel system, anywhere on the deck. This is 

particularly useful when used in conjunction with Sub-method. Care must be taken when 

using this part of the software as the z-axis does not automatically return to a safe height 

above the deck, but instead moves the 12-channel system along the specific z-axis height 

that is seen on the screen. 

 

 

 
  

 

C. Instrument programming  

 

Before programming a specific method note all of the specific steps that are likely to be 

carried out in the process that needs to be accomplished. Below is an example of some of 

the steps involved in a basic Method. 

 

1. Prime the 12 channel system and home. 

2. Move to Row 1 of Box 1 of PhyTip columns, move robot tower down and pick up 

row 1 of PhyTip columns. 

3. Move robot tower up and the across to row 1 of sample plate at position 7. 

4. Move tower down so that PhyTip columns enter the sample. 

5. Begin preprogrammed Capture Step. 

6. Upon completion of Capture step, bring tower up and move across to row 1 of 

wash plate 1 in plate position 4. 

7. Move tower down so that PhyTip columns enter wash buffer 1. 

8. Begin preprogrammed Wash 1 Step. 

9. Upon completion of Wash step 1, bring tower up and move across to row 1 of 

wash plate 2 in plate position 5.  

10. Move tower down so that PhyTip columns enter wash buffer 2. 

11. Begin preprogrammed Wash 2 Step. 

12. Upon completion of wash step 2, bring tower up and move across to row 1 of 

Enrichment Step in plate position 8. 
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13. Move tower down so that PhyTip columns enter Elution buffer. 

14. Begin preprogrammed Enrichment step. 

15. Upon completion of this step bring tower up and move back to row 1 of the 

original tip box in position 1. Move tower down and discard tips in row 1. 

16. Repeat the process for row 2, etc. 

 

 

The robotics tower is stepper motor driven and as such can be controlled by discrete steps 

in both the X and Z axis. In the Z-axis, there are 4,725 steps and in the X-axis, there are 

39,100 steps. The robotics head can be driven to any of these steps by entering position 

numbers in the appropriate part of the software. Standard methods, built into the 

software, already have these positions preprogrammed. 

 

To simplify this process the following standard and guidelines will help to speed up the 

process of programming: 
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When using the 200+ and 1200+ 1- channel systems: 

 

The simple programming of the software allows the user to move to any position and any 

row. However, to set the height of the tips, use these guidelines: 

 

For z-axis heights in positions 3,4,5,7 & 8 it, is assumed a PhyTip plate is used. 

 

For z-axis heights: 

 
2 mL Deep Well Plate (PCP 96-20-10) 

    Column 
Volume 

(mL) 

Resin Bed 
Volume 

(mL) 
Position 

3 
Position 

4 
Position 

5 
Position 

6 
Position 

7 
Position 

8 

1000 transfer tip 
      1000W transfer tip 
      1200 transfer tip 2160 2160 2160 2060 2135 2135 

1000 10 2350 2350 2350 
 

2325 2325 

1000 20 2660 2660 2660 
 

2575 2575 

1000 40 2660 2660 2660 
 

2575 2575 

1000 80 2660 2660 2660 
 

2575 2575 

1000 160 2660 2660 2660 
 

2575 2575 

1000 320 2980 2980 2980 
 

2970 2970 

        250 mL Micro Plate (PCP 96-00-10) 
     Column 

Volume 

(mL) 

Resin Bed 
Volume 

(mL) 
Position 

3 
Position 

4 
Position 

5 
Position 

6 
Position 

7 
Position 

8 

250 transfer tip 
   

4070 
  250W transfer tip 

      200 5 4280 4280 4280 
 

4225 4225 

200 20 4280 4280 4280 
 

4225 4225 

1000 10 2705 2705 2705 
 

2650 2650 

1000 20 2705 2705 2705 
 

2650 2650 

1000 40 2705 2705 2705 
 

2650 2650 

1000 80 2705 2705 2705 
 

2650 2650 

1000 160 2705 2705 2705 
 

2650 2650 

1000 320 Not recommended 
 

Not recommended   

 

*  The system defaults to automatically load tips with the ñLoadtipsò command. The user 

should NOT program a down 4210 and follow this with a ñLoadtipsò command. 

 

 

D.  Reagents 

 

1. Preparing samples for Capture ï Purify - EnrichÊ 
 

It is recommended that prior to the process of purification and enrichment by PhyTip 

columns, all samples be checked for particulates and clarity. If the final solution to be 
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purified appears cloudy or contains particulates, it is recommended to spin the samples 

down one more time at 3,000 g for 5 minutes. 

 

Samples can be placed in any position. However the default methods all have samples 

placed in position 7. With the chiller (positions 7 & 8), it is possible to maintain both the 

pre-purified material and the purified sample at sub ambient temperatures. 

 

2. Preparing wash buffer(s) for Purification process 

 

Refer to the Product Insert that is included with each Affinity resin for details on each 

buffer used in the purification process. Some buffers are shipped as concentrates and will 

require dilution before use. 

 

3. Prepare Elution Buffer for Enrichment process 

 

Refer to the Product Insert that ships with each Affinity resin for details on the Elution 

Buffer used in the enrichment process. If using Protein A or Protein G or ProPlus affinity 

resins, it is recommended to add Neutralization Buffer at the end of the Enrichment step 

in order to return the sample to physiological pH. A separate Neutralization step should 

be incorporated into the automated purification process of the MEA (see standard 

methods). 

 

For the 200+ system, once the elution buffer has been added to the elution plate, the user 

has the option of placing the PhyTip Cover over the plate (see separate instructions). 

Place the PhyTip Holder over the plate in order to retain the plate in position during the 

final elution process. 

 

4. Load the appropriate Method File 

 

To load the appropriate Method File, go to File on the user screen. Enter Open and the 

choice of Protocol or Method will be shown. Enter Method and hit OK . This will take 

you to folders containing the preprogrammed method files available to run.  Select the 

required file and press Open. The Method will now be available for the system to run. To 

verify the method click on Method ï Edit , this displays the robotic steps and all of the 

linked protocols that constitute the given method. To run this method, press Method ï 

Execute. 

 

The PC is in constant communication with the MEA. Never run other programs while 

running the PhyNexus Operating Software. The PC is a part of the MEA system and as a 

dedicated system should never be used on a network. 

 

5. Store/analyze samples 

 

Once the final enrichment step has been completed, samples will be ready for 

storage/analysis.  
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Standard Methods 

 

Example 1 - IMAC : 
 

Figure 1 below is an example of a standard method of Capture, Purify, Enrich using Ni-

IMAC PhyTip columns for one row of 12 x 200 ɛL samples.  

Deck configuration for this example is: 

 

Position 1, Row 1:  IMAC 200+ PhyTip columns 

Position 2, Row 1:  Empty 

Position 3, Row 1:  Empty 

Position 4, Row 1:  Recommended volume = 200 ɛL of Wash 1 

Position 5, Row 1:  Recommended volume = 200 ɛL of Wash 2 

Position 6, Row 1:  Empty 

Position 7, Row 1:  Recommended volume = 200 ɛL of Sample 

Position 8, Row 1:  20 ɛL Elution 

 

RearFront

Position

1

2

3

4

5

6

7

8

PhyTips

Sample plate

Wash 1

Wash 2

Elution

 
 

 

 

 

 

 

 

Figure 1 Standard Method for Capture, Purify & Enrich 

 

PhyTip Columns 
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Command Parameters (if any) 

Home Auto Controller   

Home Controller   

Execute Protocol IMAC Air Gap 

Position 1,1 

Loadtips   

Position 7,1 

Down 4225 

Execute Protocol IMAC Capture 

Position 4,1 

Down 4280 

Execute Protocol IMAC Wash1 

Position 5,1 

Down 4280 

Execute Protocol IMAC Wash2 

Position 8,1 

Down 4225 

Execute Protocol IMAC Elution 

Position 1,1 

Down 4100 

Eject   

Home Auto Controller   

 

This method shows the automated movement of the 12 channel system for 1 row of 

samples. In detail this can be broken down as follows: 

 

1. Homing the system 

 

Command Parameters (if any) 

Home Auto Controller   

Home Controller   

Execute Protocol IMAC Air Gap 

Position 1,1 

Home Auto Controller moves the robotics tower to the Home position ï full left 

position. 

Home Controller performs a zeroing of the 12 channel system followed by a resetting of 

the system to zero. 
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Execute (IMAC Air Gap) executes a stored protocol which in this case is setting the 12-

channel-system prior to attachment of PhyTip columns. The 12-channel system 

withdraws air into the syringes to create an air buffer in the system that will later be used 

to push liquid out of the PhyTip columns. The volume of air will vary depending on the 

specific set of protocols being used. 

Position 1, Row 1 moves the robotics tower over position number 1 and row 1(the tray of 

PhyTip columns). 

 

2. Moving the PhyTip Columns and Capturing the Sample 

 

Load tips   

Position 7,1 

Down 4225 

Execute Protocol IMAC Capture 

 

 

Load tips moves the 12 channel system down towards the tips in row 1, then positions 

the 12 channel system at an angle to load and then secure all 12 PhyTip columns. 

Position 7, Row 1 automatically moves the robotics tower to the full extent (Position 0) 

and then moves it over to position 7, row 1 (the plate holding the sample to be purified). 

Down moves the robotics head with PhyTip columns down into the sample solution in 

row 1 of position 7. This is a predefined position of 4225 (assumes use of PhyNexus-

recommended plates with known dimensions) in readiness for the Capture step. 

Execute (IMAC Capture) executes the stored protocol that implements the Capture 

process with a given number of cycles, flow rates, volumes and pauses, e.g. in the 

standard method, this will be a volume of 170 ɛL for 2 cycles at a flow rate of 250 

ɛL/min with 10 second pauses at the end of each step. Also note that at the end of the 

capture step, the last cycle expels 172 ɛL to make sure all of the sample solution is 

removed. 

 

3. Wash and Elution Steps 

Position 4,1 

Down 4280 

Execute Protocol IMAC Wash1 

Position 5,1 

Down 4280 

Execute Protocol IMAC Wash2 

Position 8,1 

Down 4225 

Execute Protocol IMAC Elution 

Position 1,1 

Down 4100 

Eject   

Home Auto Controller   

 

Position 4, Row 1 moves the robotics tower to the full extend position (Position 0), and 

then moves it over to position 4, row 1 ready for the first wash step. 
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Down 4280 moves the robotics tower down to predefined position of 4280 (assumes use 

of PhyNexus-recommended plates with known dimensions) for the wash step. 

Execute (IMAC Wash 1) implements the stored protocol for the first wash step. This 

protocol, like Capture, will control the flow rate, volume, pause and number of cycles 

involved in this step. 

Position 5, Row 1 moves the robotic tower up to the fully extended zero position and 

then moves it to position 5 and row 1 in readiness for the next wash step.  

Down 4280 moves the robotics tower down to predefined position of 4280 (assumes use 

of PhyNexus-recommended plates with known dimensions) for the next wash step. 

Execute (IMAC Wash 2) implements the stored protocol for the second wash step. This 

protocol, like Wash 1, will control the flow rate, volume, pause and number of cycles 

involved in this step. 

Position 8, Row 1 moves the robotics tower to the full extend position (Position 0) and 

then moves it over to position 8, row 1, ready for the elution step. 

Down moves the robotics tower down to predefined position of (this assumes use of 

PhyNexus-recommended labware with known dimensions) for the elution step. 

Execute (IMAC Elution) implements the stored protocol for the elution step. This 

protocol, like Capture, will control the flow rate, volume, pause and number of cycles 

involved in this step. Note at the end of this step, the last expel step is greater volume 

than the other expel steps in order to maximize the total volume of elution buffer returned 

to the elution plate. 

Position 1, Row 1 moves the robotics tower to the full extend position (Position 0) and 

then moves it over to position 1, row 1, ready for the ejection of the PhyTip columns. 

Down 4100 moves the robotics tower down to predefined position of 4100 ready to eject 

the PhyTip columns back into their original position in row 1. 

Eject is a command to remove all of the now used PhyTip columns. 

Home Auto Controller takes the robotics tower back to its safe starting position and 

completes the purification of 1 row of samples. 

 

If using this program as a template, just cut and paste the entire page and replace row 1 

with row 2, etc. 

 

When a method is running, each step of the process will display on the screen. 

Completed steps will display Green, while steps In Progress will display Blue. 
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Example 2 ï Protein A: 
 

Figure 2 below is an example of a modified method (without chiller) of Capture, Purify 

& Enrich for Protein A for one row of 12 x 200 ɛL samples. For information on 

configuration of the instrument with and without chiller, see page 29.   

 

Deck configuration for this example is as below. 

 

Position 1, Row 1:  Protein A 200+ PhyTip columns 

Position 2, Row 1:  Rainin LTS Tips 

Position 3, Row 1:  Empty 

Position 4, Row 1:  200 ɛL of Wash 1 

Position 5, Row 1:  200 ɛL of Wash 2 

Position 6, Reservoir with Neutralization Buffer 

Position 7, Row 1:  200 ɛL of Sample 

Position 8, Row 1:  20 ɛL Elution 

 

RearFront

Position

1

2

3

4

5

6

7

8

PhyTips

Sample plate

Wash 1

Wash 2

Elution

Standard Tips

Neutralization

Reservoir

 
 

 

 

 

 

 

PhyTip Columns 
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Figure 2  Standard method including addition of Neutralization step  

 

Command Parameters (if any) 

Home Auto Controller   

Home Controller   

Execute Protocol ProA Air Gap 

Position 1,1 

Load tips   

Position 7,1 

Down 4225 

Execute Protocol ProA Capture 

Position 4,1 

Down 4280 

Execute Protocol ProA Wash1 

Position 5,1 

Down 4280 

Execute Protocol ProA Wash2 

Position 8,1 

Down 4225 

Execute Protocol ProA Elution 

Position 1,1 

Down 4100 

Eject   

Eject   

Position 2,1 

Load tips   

Execute Protocol ProA Intake 20uL 

Position 6,1 

Down 4070 

Execute Protocol ProA Intake 5uL 

Position 8,1 

Down 4140 

Execute Protocol ProA Expel 25uL 

Position 2,1 

Down 4100 

Eject   

Home Auto Controller   

 

 

This method shows the automated movement of the 12 channel system for 1 row of 

samples. In detail, this can be broken down as follows: 

 

 

 

 

 

 

1. Homing the system 
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Command Parameters (if any) 

Home Auto Controller   

Home Controller   

Execute Protocol ProA Air Gap 

Position 1,1 

 

Home Auto Controller moves the robotics tower to the Home position ï full left 

position. 

Blowout performs a complete blowout of the 12 channel system. 

Home Controller performs a zeroing of the 12 channel system followed by a resetting of 

the system to zero. 

Execute (ProA Air Gap) executes a stored protocol which in this case is setting the 12-

channel-system prior to attachment of PhyTip columns. The 12-channel system 

withdraws air into the syringes to create an air buffer in the system that will later be used 

to push liquid out of the PhyTip columns. The volume of air will vary depending on the 

specific set of protocols being used. 

Position 1, Row 1 moves the robotics tower over position number 1 and row 1(The tray 

of PhyTip columns). 

 

2. Moving the PhyTip Columns and Capturing the Sample 

 

Load tips   

Position 7,1 

Down 4225 

Execute Protocol Pro A Capture 

 

 

Load tips moves the 12 channel system down towards the tips in row 1 then moves the 

12 channel system at an angle to load and secure all 12 PhyTip columns. 

Position 7, Row 1 automatically moves the robotics tower to the full extent (Position 0) 

and then moves it over to position 7, row 1 (the plate holding the sample to be purified). 

Down moves the robotics head with PhyTip columns down into the sample solution in 

row 1 of position 7. This is a predefined position of 4225 (assumes use of PhyNexus-

recommended plates with known dimensions) in readiness for the Capture step. 

Execute (ProA Capture) executes the stored protocol that implements the Capture 

process with a given number of cycles, flow rates, volumes and pauses e.g. in the 

standard method this will be a volume of 170 ɛL for 2 cycles at a flow rate of 250 ɛL/min 

with 10 second pauses at the end of each step. Also note that at the end of the capture 

step, the last cycle expels 172 ɛL to make sure all of the sample solution is removed. 
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3. Wash and Elution Steps 

 

Position 4,1 

Down 4280 

Execute Protocol Pro A Wash1 

Position 5,1 

Down 4280 

Execute Protocol Pro A Wash2 

Position 8,1 

Down 4225 

Execute Protocol Pro A Elution 

Position 1,1 

Down 4100 

Eject   

Eject   

 

Position 4, Row 1 moves the robotics tower to the full extend position (Position 0) and 

then moves it over to position 4, row 1 ready for the first wash step. 

Down 4280 moves the robotics tower down to predefined position of 4280 (assumes use 

of PhyNexus-recommended plates with known dimensions) for the wash step. 

Execute (Pro A Wash 1) implements the stored protocol for the first wash step. This 

protocol, like Capture, will control the flow rate, volume, pause and number of cycles 

involved in this step. 

Position 5, Row 1 moves the robotic tower up to the fully extended zero position and 

then moves it to position 5 and row 1 in readiness for the next wash step.  

Down 4280 moves the robotics tower down to predefined position of 4280 (assumes use 

of PhyNexus-recommended plates with known dimensions) for the next wash step. 

Execute (Pro A Wash 2) implements the stored protocol for the second wash step. This 

protocol, like Wash 1, will control the flow rate, volume, pause and number of cycles 

involved in this step. 

Position 8, Row 1 moves the robotics tower to the full extend position (Position 0) and 

then moves it over to position 8, row 1 ready for the elution step. 

Down moves the robotics tower down to predefined position of 4225 (assumes use of 

PhyNexus-recommended plates with known dimensions) for the elution step. 

Execute (Pro A Elution) implements the stored protocol for the elution step. This 

protocol, like Capture, will control the flow rate, volume, pause and number of cycles 

involved in this step. Note at the end of this step, the last expel step is greater volume 

than the other expel steps in order to maximize the total volume of elution buffer returned 

to the elution plate. 

Position 1, Row 1 moves the robotics tower to the full extend position (Position 0) and 

then moves it over to position 1, row 1 ready for the ejection of the PhyTip columns. 

Down 4100 moves the robotics tower down to predefined position of 4100, ready to eject 

the PhyTip columns back into their original position in row 1. 

Eject is a command to remove all of the now used PhyTip columns. 
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4. Neutralization 

 

Position 2,1 

Load tips   

Execute Protocol ProA Intake 20uL 

Position 6,1 

Down 4070 

Execute Protocol ProA Intake 5uL 

Position 8,1 

Down 4140 

Execute Protocol ProA Expel 25uL 

Position 2,1 

Down 4100 

Eject   

Home Auto Controller   

 

Position 2, Row 1 moves the robotics tower over position number 2 and row 1 (The tray 

of Rainin LTS Tips). 

Load tips moves the 12 channel head down to the pre assigned position to automatically 

load the tips onto the 12 channel system. 

Execute (ProA Intake 20uL) executes a stored protocol which in this case the 12-channel 

system withdraws air into the syringes before the LTS tips are lowered into the 

neutralization buffer. It does this to create an air buffer in the system that will later be 

used to push liquid out of the LTS tips. The volume of air will vary depending on the 

specific set of protocols being used. 

Position 6, Row 1 automatically moves the robotics tower to the full extent (Position 0) 

and then moves it over to position 6, (the Neutralization Buffer Reservoir). 

Down 4070 moves the robotics head with Tips down into the neutralization buffer. This 

is a predefined position of 4070 in readiness for removing the Neutralization buffer. 

Execute (ProA Intake 5uL) executes the stored protocol that implements aspiration of 5 

ɛL of neutralization buffer into the 12 LTS Tips. 

Position 8, Row 1 automatically moves the robotics tower to the full extent (Position 0) 

and then moves it over to position 8, row 1(the row that contains the purified protein). 

Down 4140 moves the robotics head with Tips with neutralization buffer down to the 

predefined position of 4140 in readiness for adding the Neutralization buffer. 

Execute (ProA Expel 25uL) executes the stored protocol that implements the dispense of 

25 ɛL of neutralization buffer into row 1. 

Position 2, Row 1 automatically moves the robotics tower to the full extent (Position 0) 

and then moves it over to position 2, row 1 (the original tray for the Rainin Tips). 

Down 4100 moves the robotics head with Tips down to a predefined position of 4100 in 

readiness for removing the Tips from the 12 channel system. 

Eject removes the tips into their original position. 

Home Auto Controller takes the robotics tower back to its safe starting position and 

completes the purification of 1 row of samples. 

 

If using this program as a template, just cut and paste the entire page and replace row 1 

with row 2, etc. 
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Example 3 
 

Optimization Method. 

 

The MEA can be used as a very rapid optimization platform to assess the optimum 

conditions for purifying protein samples. Below is an experimental design format as an 

example, with Ni-IMAC resin: 

 

Capture 

 

Prepare the standard 96-well sample plate and program the MEA as follows: 

For the Capture protocol are programmed so that Rows A, C, E & G have 2 Capture 

cycles, and Rows B, D, F & H have 4 Capture cycles. 

 

 Column           

Row 1 2 3 4 5 6 7 8 9 10 11 12 

A 2 2 2 2 2 2 2 2 2 2 2 2 

B 4 4 4 4 4 4 4 4 4 4 4 4 

C 2 2 2 2 2 2 2 2 2 2 2 2 

D 4 4 4 4 4 4 4 4 4 4 4 4 

E 2 2 2 2 2 2 2 2 2 2 2 2 

F 4 4 4 4 4 4 4 4 4 4 4 4 

G 2 2 2 2 2 2 2 2 2 2 2 2 

H 4 4 4 4 4 4 4 4 4 4 4 4 

 

 

 

Purify  

 

The wash process for purification can be optimized when using Ni-IMAC resin by 

varying the concentration of the Imidazole in the wash buffer.  

 

In this example, rows A&B have 0 mM Imidazole in the wash buffer, rows C&D have 5 

mM, E&F have 10 mM, and G&H have 20 mM Imidazole.  

 

 

 

 

 

 

 

 

 

 

 

 



 

Version 1.7.9  Mar. 7, 2013 

Copyright © 2013, PhyNexus, Inc., All Rights Reserved. 

 

31 

 Column           

Row 1 2 3 4 5 6 7 8 9 10 11 12 

A 0 0 0 0 0 0 0 0 0 0 0 0 

B 0 0 0 0 0 0 0 0 0 0 0 0 

C 5 5 5 5 5 5 5 5 5 5 5 5 

D 5 5 5 5 5 5 5 5 5 5 5 5 

E 10 10 10 10 10 10 10 10 10 10 10 10 

F 10 10 10 10 10 10 10 10 10 10 10 10 

G 20 20 20 20 20 20 20 20 20 20 20 20 

H 20 20 20 20 20 20 20 20 20 20 20 20 

 

 

 

 

Purification Step 2 

 

This can be a repeat of Wash 1, using the exact same methodology. 

 

Enrich 

 

The final elution step can now be compared using two concentrations of Imidazole to 

remove the his-tagged protein, e.g. columns 1-6 are eluted with a 150 mM Imidazole 

buffer and columns 7-12 are eluted with a 250 mM Imidazole buffer. 

 

 
 

 

 

This one experiment, which can be run in less than 2 hours, allows for a statistically 

significant number of comparisons of capture conditions, wash conditions and elution 

conditions. 

 

Column

Row 1 2 3 4 5 6 7 8 9 10 11 12

A 150 150 150 150 150 150 250 250 250 250 250 250

B 150 150 150 150 150 150 250 250 250 250 250 250

C 150 150 150 150 150 150 250 250 250 250 250 250

D 150 150 150 150 150 150 250 250 250 250 250 250

E 150 150 150 150 150 150 250 250 250 250 250 250

F 150 150 150 150 150 150 250 250 250 250 250 250

G 150 150 150 150 150 150 250 250 250 250 250 250

H 150 150 150 150 150 150 250 250 250 250 250 250
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Standard Methods: 
 

The following standard methods have been built into the standard operating software: 

 

For 200+ PhyTip columns and 200 + 12 channel system 

 

Position 7 is for the sample and position 8 is for elution. 

 

1. Protein A with included neutralization step 

2. Protein G with included neutralization step 

3. IMAC    

4. Glutathione 

 

For 1000+ PhyTip columns and 1000 + 12 channel system 

 

Position 7 is for the sample and position 8 is for elution. 

 

1. Protein A with included neutralization step 

2. Protein G with included neutralization step 

3. IMAC      

4. Glutathione 
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Full x-axis and z-axis positions. 
For the 200+ 12 channel system: 

 

 
 

 

For the 1000+ 12 channel system: 
 

x-axis # x-axis #

Position 1 Row 1 0 Position 2 Row 1 5648

PhyTip columns Row 2 567 PhyTip columns Row 2 6215

Row 3 1134 Row 3 6782

Row 4 1701 Row 4 7349

Row 5 2268 Row 5 7916

Row 6 2834 Row 6 8482

Row 7 3401 Row 7 9049

Row 8 3968 Row 8 9616

PhyTip columns z-axis: Rainin LTS Tips z-axis:
Load = 4270. Eject = 4100 Load=4270. Eject = 4100

x-axis # x-axis #

Position 3 Row 1 11240 Position 4 Row 1 16723

Sample Plate Row 2 11807 Wash 1 Row 2 17290

(PhyTip Plate) Row 3 12374 (PhyTip Plate) Row 3 17857

Row 4 12941 Row 4 18424

Row 5 13508 Row 5 18991

Row 6 14074 Row 6 19558

Row 7 14641 Row 7 20124

Row 8 15208 Row 8 20691

PhyTip columns z-axis: PhyTip columns z-axis:

Sample Plate= 4280 Wash Plate= 4280

x-axis # Position 6 x-axis #

Position 5 Row 1 22206 Neutralization

Wash 2 Row 2 22773 Reservoir 27674

(PhyTip Plate) Row 3 23340 Rainin LTS Tips z-axis:

Row 4 23907 Neutralization= 4070

Row 5 24474

Row 6 25041

Row 7 25608

Row 8 26175

PhyTip columns z-axis:

Wash Plate= 4280

x-axis # x-axis #

Position 7 Row 1 29152 Position 8 Row 1 34640

Elution Row 2 29719  Row 2 35207

(PhyTip Plate) Row 3 30286 Row 3 35774

Row 4 30853 Row 4 36341

Row 5 31420 Row 5 36908

Row 6 31986 Row 6 37474

Row 7 32553 Row 7 38041

Row 8 33120 Row 8 38608

With Cooling System z-axis With Cooling System z-axis

PhyTip Elution = 4225 PhyTip Elution = 4225

Rainin LTS = 4140 Rainin LTS = 4140

Without Cooling System z-axis Without Cooling System z-axis

PhyTip Elution = 4280 PhyTip Elution = 4280

Rainin LTS = 4195 Rainin LTS = 4195
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Protocols 

 

x-axis # x-axis #

Position 1 Row 1 0 Position 2 Row 1 5648

PhyTip columns Row 2 567 PhyTip columns Row 2 6215

Row 3 1134 Row 3 6782

Row 4 1701 Row 4 7349

Row 5 2268 Row 5 7916

Row 6 2834 Row 6 8482

Row 7 3401 Row 7 9049

Row 8 3968 Row 8 9616

PhyTip columns z-axis: Rainin LTS Tips z-axis:
Load = 3600. Eject = 3500 Load=3600. Eject = 3500

x-axis # x-axis #

Position 3 Row 1 11240 Position 4 Row 1 16723

Sample Plate Row 2 11807 Wash 1 Row 2 17290

(PhyTip Deep Well) Row 3 12374 (PhyTip Deep Well) Row 3 17857

Row 4 12941 Row 4 18424

Row 5 13508 Row 5 18991

Row 6 14074 Row 6 19558

Row 7 14641 Row 7 20124

Row 8 15208 Row 8 20691

PhyTip columns z-axis: PhyTip columns z-axis:

Sample Plate= 2310 Wash Plate= 2310

x-axis # Position 6 x-axis #

Position 5 Row 1 22206 Neutralization

Wash 2 Row 2 22773 Reservoir 27674

(PhyTip Deep Well) Row 3 23340 Rainin LTS Tips z-axis:

Row 4 23907 Neutralization= 2050

Row 5 24474

Row 6 25041

Row 7 25608

Row 8 26175

PhyTip columns z-axis:

Wash Plate= 2310

x-axis # x-axis #

Position 7 Row 1 29152 Position 8 Row 1 34640

Elution Row 2 29719  Row 2 35207

(PhyTip Plate) Row 3 30286 Row 3 35774

Row 4 30853 Row 4 36341

Row 5 31420 Row 5 36908

Row 6 31986 Row 6 37474

Row 7 32553 Row 7 38041

Row 8 33120 Row 8 38608

With Cooling System z-axis With Cooling System z-axis

PhyTip Elution = 2310 PhyTip Elution = 2310

Rainin LTS = 2120 Rainin LTS = 2120

Without Cooling System z-axis Without Cooling System z-axis

PhyTip Elution = 2365 PhyTip Elution = 2365

Rainin LTS = 2175 Rainin LTS = 2175
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Protocols define the flow rates, volume and pauses associated with the process of 

Capture-Purify-Enrich. There are a series of standard protocols that have been stored in 

the software, e.g.: 

 

200+ ProA Condition 

200+ ProA Capture 

200+ ProA Wash 1 

200+ ProA Wash 2 

200+ ProA Elute 

200+ ProA Condition 2 

200+ ProA Intake 5 ɛL 

200+ ProA Expel 5 ɛL 

(These protocols represent a series of steps that would be used for the 200+ PhyTip 

columns containing 5 µL Protein A affinity resin; there are others for 200+ Protein G, 

IMAC and Glutathione plus 1000+ Protein A, Protein G, IMAC and Glutathione). 

 

The standard methods have been written to incorporate a series of the standard protocols 

so that the process of Capture-Purify-Enrich can simply be carried out without the need 

for further programming. 

 

200 + Protocol 
 

As an example of these protocols when using the standard 200+ Protein A Method, there 

are several ñExecuteò steps that reference the following steps: 

 

 
 

Air Gap : This conditions the 12-channel system to prepare for the complete process of 

moving liquids over the resin bed in the PhyTip columns. The final process of elution 

will often require only 10 ɛL of elution buffer to be moved over the resin bed and then 

expelled. In order to be sure that all of this liquid can be blown out, a sufficient reservoir 

of air must be added to the 12-channel system before the PhyTip columns are attached. 

In this case 10 ɛL of air is moved into the 12 channel system at a rate of 1 mL/minute. 

 

 

 

 

 

 

 

 

 

 

 

200+ Pro A Condition

Volume (mL) Rate (mL/min) Times to do Delay (sec)

0.01 1 1 0
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200+ Pro A Capture   

Volume (mL) Rate (mL/min) Times to do Delay (sec) 

0.17 0.25 1 10 

-0.17 0.25 1 10 

0.17 0.25 1 10 

-0.17 0.25 1 10 

0.17 0.25 1 10 

-0.17 0.25 1 10 

0.17 0.25 1 10 

-0.172 0.25 1 10 

Capture: Passes the sample over the resin bed enabling the Protein A affinity resin to 

bind the protein of interest. In this case 170 ɛL of sample is moved into the PhyTip 

column (Intake) and 170 ɛL is moved out (Expelled). Intake can be seen as the positive 

number and expel the negative number, also note that all expel steps are colored red. 

Note that there are four expel steps. Therefore, four cycles of Capture and that at the end 

of the fourth cycle 172 ɛL is expelled from the PhyTip column. This extra volume is part 

of the original 10 ɛL Condition step and helps to remove as much sample solution as 

possible prior to the Wash steps. 

 

The Flow Rate is 250 ɛL/min (expressed as 0.25 mL/min) with a delay of 10 seconds at 

the end of each step. This delay step of 10 seconds is built into the system to allow for the 

full equilibration of all PhyTip columns in all positions.  

 

To modify any of the parameters, double click on the parameter line and an ñEdit 

Protocol Stepò screen will display. This has several boxes that can be modified (see 

Section B, Detailed software Information): Volume (sets the desired volume), Volume 

Units: (references the volume, with mL or ɛL available), Direction (Expel or Intake), 

Volume Prior to this Step (indicates last volume input), How Many Times (number of 

times to repeat sequentially this specific step), Rate (the flow rate), Rate units (shows 

mL/hr, mL/min, ɛL/hr, ɛL/min) and Delay (in seconds). 

 

 
 

Wash 1: This is the first of two washing (Purification) steps, here two cycles of moving 

170 ɛL of Wash Buffer 1 is accomplished at a flow rate of 500 ɛL/min (expressed as 0.5 

mL/min) with a delay of 10 seconds at the end of each step. Note that on the final expel 

step, the volume is the same as all the intake steps. At this first step, there is no need to 

expel any further volume since the next step is another wash step. 

 

200+ Pro A Wash 1

Volume (mL) Rate (mL/min) Times to do Delay (sec)

0.17 0.5 1 10

-0.17 0.5 1 10

0.17 0.5 1 10

-0.17 0.5 1 10
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Wash 2: This is the second wash step, again two cycles at the same flow rate as Wash 

Step 1. Now however, there is a larger volume of wash buffer (180 ɛL) and at the final 

expel step there is an extra 2 ɛL of volume expelled from the PhyTip column (-182 ɛL). 

 

 
 

Elute: The final step in the purification process uses 5 cycles of rapid flow elution over 

the resin bed. In this case, although only 10 ɛL is being used as the Elution volume, the 

protocol is stored as 50 ɛL. This difference between actual physical volume and 

programmed volume allows for all of the Elution buffer to pass over the resin bed, thus 

maximizing the total yield of purified protein that can be obtained from the column. It is 

essential to ñoverdriveò this step (50 ɛL to pick up 10 ɛL of liquid) to overcome the 

surface tensions and pressures that are caused by the initial insertion of the tip and bed 

resistance in the tip. The required balance is to pull up enough to get the fluid to move, 

but not too much such that the volume of fluid pulls an air bubble. 

 

As a programming guideline, if a higher volume for elution is needed, add 40 to the final 

volume number to obtain the programmed elution volume, e.g. if 30 ɛL is the final 

elution volume required, program 30 + 40 = 70 ɛL for the final elution volume. This 

guideline is valid for elution volumes less than 75 µl.  For elution volumes greater or 

equal to 75 µl, simply program that same volume.  

 

Again note that the final step expels 56 ɛL to maximize the volume of Elution Buffer 

returned (Note: Initial Conditioning step has Intake volume of 10 ɛL. Capture has excess 

expel of 2 ɛL; Wash 2 has excess expel of 2 ɛL; and the final Elution step has an excess 

expel of 6 ɛL, thus balancing the Intake and Expel for the entire process). 

 

200+ ProA Condition 2   

Volume (mL) Rate (mL/min) Times to do Delay (sec) 

0.02 1 1 0 

200+ Pro A Wash 2

Volume (mL) Rate (mL/min) Times to do Delay (sec)

0.18 0.5 1 10

-0.18 0.5 1 10

0.18 0.5 1 10

-0.182 0.5 1 10

200+ Pro A Elute

Volume (mL) Rate (mL/min) Times to do Delay (sec)

0.05 0.5 1 10

-0.05 0.5 1 10

0.05 0.5 1 10

-0.05 0.5 1 10

0.05 0.5 1 10

-0.05 0.5 1 10

0.05 0.5 1 10

-0.05 0.5 1 10

0.05 0.5 1 10

-0.056 0.5 1 10
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Conditioning 2: this step conditions the 12 channel system prior to adding the Rainin 

LTS Tips for the Neutralization Step. Air (20 ɛL) is taken in at a flow rate of 1 mL/min. 

 

200+ ProA Intake 5 uL   

Volume (mL) Rate (mL/min) Times to do Delay (sec) 

0.005 6 1 2 

 

Intake 5 ɛL: This step pulls 5 ɛL of neutralization buffer into the Rainin LTS Tips at a 

flow rate of 6 mL/min. 

 

200+ ProA Expel 5 uL   

Volume (mL) Rate (mL/min) Times to do Delay (sec) 

0.025 2 1 2 

 
Expel 5 ɛL: This step expels the 5 ɛL of Neutralization Buffer from the Rainin LTS Tips 

into the specified row at a flow rate of 2 mL/min. The step requires 25 uL of expel, the 

first 20 uL is air and the remaining 5 is the neutralization buffer. Note the negative 

number indicating an expel step. 

 

1000+ Protocol 

 
Below is an example of the protocols for a 1000+ PhyTip column system using IMAC as 

the affinity resin: 

 
1000+ IMAC Air Gap   

Volume (mL) Rate (mL/min) Times to do Delay (sec) 

0.09 3 1 0 

 
1000+ IMAC Capture   

Volume (mL) Rate (mL/min) Times to do Delay (sec) 

0.45 0.25 1 20 

-0.45 0.25 1 20 

0.45 0.25 1 20 

-0.45 0.25 1 20 

0.45 0.25 1 20 

-0.45 0.25 1 20 

0.45 0.25 1 20 

-0.47 0.25 1 20 

 

 

1000+ IMAC Wash 1

Volume (mL) Rate (mL/min) TImes to do Delay (sec)

0.9 0.5 1 20

-0.9 0.5 1 20

0.9 0.5 1 20

-0.9 0.5 1 20
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Note: The initial conditioning step of 90 ɛL and the subsequent combination of excess 

expels total 90 ɛL. Also the final elution volume of 20 ɛL requires an intake/expel of 250 

ɛL.    

 

As a programming guideline, if a higher volume for elution is needed, add 230 to the 

final volume number to obtain the programmed elution volume, e.g. if 30 ɛL is the final 

elution volume required, program 30 + 230 = 260 ɛL for the final elution volume. This 

guideline is valid for elution volumes less than 250 µL.  For elution volumes greater 

or equal to 250 µL, simply program that same volume.  

 

Manual methods programming 
 

The MEA software not only includes standard Methods and Protocols that can be simply 

modified, but also a feature that allows the user to calculate and program specific 

positions on the deck. The standard windows screen shows five basic headings: 

 

                            File ï Protocol ï Method ï Options ï Help.  

 

File is the standard New/Open/Select Default Method /Save/Save as found in most 

Windows applications. 

Protocol contains Execute/Edit. Execute begins the loaded Protocol and Edit allows the 

user to Edit the loaded Protocol. 

Method contains Execute/Verify/Edit. Execute begins the loaded Method, Verify checks 

that the Method can be operated and Edit allows the user to Edit the loaded Method. 

Options contain Communications/Syringe/Calibration/Manual 

Positioning/Submethods/Perform Dry Run. Communications sets the COM port for the 

1000+ IMAC Wash 2

Volume (mL) Rate (mL/min) TImes to do Delay (sec)

0.5 0.5 1 20

-0.5 0.5 1 20

0.5 0.5 1 20

-0.52 0.5 1 20

1000+ IMAC Elute

Volume (mL) Rate (mL/min) TImes to do Delay (sec)

0.25 0.5 1 20

-0.25 0.5 1 20

0.25 0.5 1 20

-0.25 0.5 1 20

0.25 0.5 1 20

-0.25 0.5 1 20

0.25 0.5 1 20

-0.25 0.5 1 20

0.25 0.5 1 20

-0.3 0.5 1 20
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MEA and recognizes the serial number of the 12-channel system. Syringe verifies the 12 

channel system type (200+ or 1000+). Manual Positioning allows control of the MEA 

tower. Submethods organize and store labware definitions. Perform Dry Run is used to 

run the MEA movements but disables the 12-channel functions. 

Help shows the About information regarding the system. 

 

To access the ability to specify x-z positioning of the 12 channel system press Shift ï Alt, 

this will add two new functions to the Options field: 

 

Simulation Mode: allows the user to run a method on the software only, disconnecting the 

functions of the MEA. This can be used to verify/check that all of the software 

programming is compatible without running the MEA. 

 

Terminal: allows the user to move the 12-channel system, via a series of typed 

commands to any position on the deck. This function allows the user to verify specific 

positions on the MEA and to design new methods that are different to the stored methods. 

Specific position commands can be entered in the window and once the ñsendò command 

is hit, the robotics tower with 12-channel system will move to that specific position. 

Commands are entered in the window to the right of the ñsendò command button. Once 

the command has been entered, press ósend.ô This will initiate the command and in the 

screen box above this window there will be a confirmation that the command has been 

implemented e.g. Response OK. 

 

Commands 
 

Home: moves the robotics tower and 12 channel system back to starting home position 

(x= 0 and z=0) 

 

Down #:  (where # = any number between 0 and 4275) moves the 12 channel system 

down to a specific point. It is recommended to place two Tips that will be used in the 

process on positions 1 and 12 of the 12 channel system in order to position the base of the 

tip correctly. Note that when the 12-channel system is in the full up position (0), then to 

move the system down, just type in the desired position number e.g. 2500. However, if 

the 12 channel system is not at the zero position e.g. 2500 and you want to move the 

system down a further 100 stepper motor points, type in Down 100 and this moves the 

system to position 2600. 

 

Up: moves the 12 channel system back to zero position, fully up. 

 

X pos - #: (where # = any number between 0 and 39,100) moves the robotics tower and 

12 channel system to a specific point on the x- axis along the deck. It is recommended to 

place two Tips that will be used in the process on positions 1 and 12 of the 12 channel 

system in order to position the tip correctly. 
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Section B 

 

1. Introduction 
 

PhyNexus auto controller software is a graphical user interface application which is 

intended to allow the user to perform the following tasks: 

 

1. Open, verify, and execute files which perform intake and expel operations. 

2. Edit and save protocol files. 

3. Open, verify, and execute method files which execute protocol files and other 

commands, such as instructions to the auto controller. 

4. Edit and save method files. 

5. Perform manual intake, expel, and blowout / home operations. 

 

The auto controller software is intended for use on Microsoft Windows platforms 

(Windows XP, 7 and 8). 

 

1.1 Conventions 

 

The auto controller software will afterwards be referred to as the app.   

 

Menu and submenu options will be referred to using the -> notation.  For example, the 

Open option under the File menu is referred to as File->Open. 

 

1.2 Definitions 

The Controller is the 12-channel pipette. 

 

A protocol is a series of steps which command the controller to intake or expel liquid.  

Each step of a protocol specifies a volume (positive to intake, negative to expel), a rate, 

and a number of times to repeat.  The post-step delays may also be specified. 

 

A method is a series of steps which group protocol(s) together and also provide some 

user-interface functionality.  The following actions can be steps of a method: 

 

1. Execute (specified by filename). 

2. Audible alert (beep). 

3. Pause for operator, display message, and wait for user input to either continue 

method or abort). 

4. Home (Controller) moves Controller pistons to the home position. 

5. Comment (solely for documentation of the method file ï not seen by the 

operator). 

6. Auto controller instructions: 

 a. Home (AutoController), reset all axes to home position. 
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 b. Down, moves Controller down to specified position 

c. Up, moves Controller up to specified position (performed automatically 

by tray command [i]) 

 d. External Pump, turns external pump on / off. 

 e. Rotate, rotates Controller to specified location. 

 f. Submethod, utilizes heights of stored plate definitions. 

 g. Home Rotate Axis, reset the rotation axis. 

h. Position above tray at specified step. 

i. Position/Row, moves Controller to specified position based upon 96-

well, SBS plates. 

 j. Eject tips from controller.  

k. Move controller down towards tray by specified number of steps. 

 l. Load tips onto controller. 

 

1.3 Compatibility  

 

The auto controller (MEA system) is assumed to be connected in between the host 

computer and the controller (the 12-channel system). No other system or options are 

compatible with the MEA system. 

 

2. How to open and execute a protocol 

 

The following window appears when the app first runs: 

 

 
The status bar (lower portion of the screen) shows the app status at any time.  Initially 

the app is not communicating with the controller, so the status bar shows the message 

ñOfflineò when it starts. 
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2.1 Open protocol file 

 

Use the File->Open menu option and select Protocol to browse for a protocol file, as 

shown below: 

 

 

 
 

Protocol files are assumed to have a .psc file extension. If the protocol file was opened 

successfully, then it may be verified, executed and/or edited. 

 

If the app displays an error message when you try to open the protocol file, then it may 

have been corrupted, e.g. via disk error or hand-editing, or the file selected is simply not a 

protocol. 

2.2 Execute  

 

Before executing the protocol, make sure of the following: 

 

1. All PhyTip columns, sample plates, wash buffers, etc., are in place. 

2. Appôs serial parameters are set to match those of the controller. 

3. The capacity of the PhyTip columns matches the volume required to be 

processed. 

 

After these items have been checked, the protocol can be executed. 

2.2.1 Check Controller Communication 

 

The app communicates with the AutoController and the controller.  The appôs 

Communication setting verifies communication to the AutoController and the Controller. 

Check this by selecting the Options->Communications menu, which pops up a dialog as 

follows: 
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Make sure that the Controller Device setting matches the serial number of the Controller. 

To select the proper AutoController Comm Port, use the Windowôs Control Panel. 

Control Panel -> System -> Hardware -> Device Manager. Expand the Ports file and note 

the USB COM Port in use. 

 

  
Note:  

 

¶ Settings for the comm port can only be changed when the app is not 

communicating with the auto controller (not executing a protocol, method or 

manual override command).  Pressing óStopô terminates communication, and 

allows these settings to be changed (see below). 

2.2.2 Check capacity setting 

 

The capacity setting may be adjusted via the Options->Syringe menu, which pops up the 

following dialog: 
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The setting shown above is for the 1200 ɛL capacity.  The app is initially set up for 200 

ɛL, but remembers the last settings used (See Registry Settings below). 

 

Also note that the current capacity is displayed on the main window of the app. 

 

The capacity setting can only be changed when the app is not communicating with the 

auto controller (not executing a protocol, method or manual override command).  

Pressing óStopô also stops communication so that these settings can be changed. 

2.2.2.1 Capacity and verification 

 

If the capacity setting is changed while a protocol is open, the user is prompted as 

follows: 

 
 

 

This message indicates that the protocol may not execute properly with the new capacity 

setting.   

2.2.2.2 Capacity and protocols 

 

If a protocol specifies a different capacity than the current app settings, the user is 

prompted as follows when the protocol file is opened: 
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Answer ñyesò to set the appôs capacity setting to match the protocol, or ñnoò to do so 

later.   

 

Note: Answering ñnoò may prevent the protocol from executing properly. 

2.2.3 Start protocol execution 

 

Once the protocol has been opened, and the controller has been prepared for protocol 

execution, select the Protocol->Execute option.  The app will establish communication 

with the controller (go online), get the controllerôs software version and capacity, disable 

the controllerôs keyboard and speaker, and get the current volume.  The protocol will then 

be automatically verified, as noted in section 2.3 below, using the controllerôs current 

volume.  Then the app will instruct the controller to execute the intake or expel steps 

contained in the protocol. 

 

The app displays the following during protocol execution: 

 

1. Status bar displays the protocol step and step type (intake/expel). 

2. Progress bar (to the right of the status bar text) shows progress in total execution 

time, as calculated by the volume and rate of each step. 

3. Volume displays the current volume in the syringe, as reported by the controller 

after the most-recently-executed step. 

4. Controller version: shows the firmware version of the controller.   

5. Version: shows the firmware version of the auto controller. 

6. Port: shows the Com port used by the Auto Controller 

 

An example is as follows: 
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When the protocol is completed, the status bar will display ñProtocol execution 

completeò and the Volume indicator will show how much volume is in the syringe at the 

end of the protocol. 

 

The protocol is automatically terminated if an error occurs during execution, and the error 

is shown in the status bar.  See ñPossible errors and corrective actionò below (section 

2.2.3.2). 

2.2.3.1 Stopping protocol execution 

 

If the protocol needs to be stopped before itôs complete, then press the Stop button.  

Pressing stop terminates the appôs execution of the protocol and will stop the protocol 

right away before the last command/step is completed. 

2.2.3.2 Possible errors and corrective action 

 

If a Port in use error results when the protocol is executed, then some other application is 

using the Com port selected (See section 2.2.1 above). Possibly a modem is plugged in 

and is being used, or the HyperTerminal app (which is found on most versions of 

Windows).  To fix this, select a different port from the Options -> Communications 

dialog and try again, or find the application which is using the port, and shut it down. 
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The error No response from controller (offline) indicates that the port selected is not 

actually connected to the controller.  Select a different port and try again.  . 

  

Controller error (command not echoed, bad checksum, invalid parameter or command) 

indicates a problem communicating with the controller over the USB cable, or an 

incompatible version of controller firmware.  Check that the USB cable is in good 

condition, and that the controller firmware version is supported by the app (see section 1 

above). 

2.3 Verify protocol 

 

Verification is performed automatically by the app prior to executing a protocol, but may 

also be invoked manually.  In this process, the app checks that the following rules are 

followed during the protocol: 

 

1. Volume never falls below zero.   

2. Volume never rises above the capacity (see also section 2.2.2.1). 

3. Flow rates are within limits for the capacity (see Appendix D). 

 

When verification is performed automatically just prior to protocol execution, the initial 

volume is assumed to be that reported by the controller. 

A protocol may be manually verified using the Protocol->Verify menu option.  In this 

case, whatever current volume is presently reported by the controller is assumed to be the 

initial volume for verification purposes.  If the app has not yet gone online, then the 

initial volume is assumed to be zero. 

 

If protocol verification fails, then an error message appears showing the line in the 

protocol at which the error occurred.  

 

 

3. How to open and execute a method 

 

Handling of methods is similar to that of protocols.   

3.1 Open Method 

 

Use the File->Open menu option and select Method to browse for a method file, as 

shown below : 
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Method files are assumed to have a .pba file extension.  If the method file was opened 

successfully, then it may be executed and/or edited.   

 

If the app displays an error message when you try to open the method file, then it may 

have been corrupted, e.g. via disk error or hand-editing, or the file selected is simply not a 

method. 

 

The MRU (most-recently-used) list in the file menu also handles method files. 

 

After opening the method file, the display will indicate the currently-open method, as 

shown below: 

 

 

3.2 Execute method 

 

Before executing the method, make sure of the following: (see section 2.2 above) 

 

1. The Controller is correctly mounted on the Auto Controller. 

2. The Appôs serial parameters are set to match those of auto controller. 

3. The Appôs capacity setting matches the Controller capacity. 

 








































